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Excel 2016 is finally released!And it’s not even 2019…
After months of preview, Microsoft has finally bitten the bullet and released the “full version”. We decide to hit the  
ground running and look at some of the new and improved features in Microsoft’s flagship product.

In other news, Microsoft has announced assistance for app developers looking to use Windows 10.  OK, it’s not exactly  
Excel, but we know some of our readers look to dabble in this domain.  Also we proudly announce the new website  
– it’s still a work in progress but we hope you will come with us for the journey…

Until next month. Liam Bastick, Managing Director, SumProduct

Microsoft has finally launched the long-anticipated new version of 
Microsoft Office.  Office 2016 has been “broadly available” (we’re not quite 
sure what that means) since September 22, whilst Office customers with 
volume licensing agreements will be able to download the software from 
October 1 (that’s today if you’ve opened this newsletter straightaway!).

With Office 2016 now “fully released”, we thought we’d take the 
opportunity to explore some of the new and improved features in Excel 
in particular.

Microsoft Power Query for Excel, which was a separate downloadable 
COM add-in for Excel 2013 and 2010 is now fully integrated into Excel.  
This means that if you are using one of the BI features (Power View, 
Power Pivot or Power Map) the rest will be turned on automatically for 
you.  The method of turning on the features has changed too.  Instead 
of File > Options > Add-Ins > Manage COM Add-ins > Go, it has now 
moved to File > Options > Advanced > Turn on data analysis features.   

We remember when we couldn’t find the Power Off button with 
Windows 8 and wonder how much enthusiasm this improvement will 
garner…

Nonetheless, Power BI can access a wide variety of sources including 
relational, structured and semi-structured databases, including OData, 
Web, Hadoop, Azure Marketplace and more.

As part of its marketing, Microsoft released a graphic that does explain the Power BI journey aptly:

Office 2016 Released

Power BI Updates
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Now that it is native functionality in Excel, there is no separate Power Query tab anymore; instead, there is a Power Query section on the Data tab 
(under ‘Get & Transform’):

• 	Automatic relationship detection: discovers and creates relationships among the tables used for your workbook’s data model.  This intelligent  
	 feature highlights when two or more tables might need to be linked together and notifies you.  With just one click, it does the work to build the  
	 relationships, which sounds great in theory. Just as with number formatting, auto-complete and conditional formatting intelligence, be 
	 prepared for Excel 2016 to get the relationships wrong upon occasion – always check its suggestions!

• 	Creating, editing and deleting custom measures: these can now be done directly from the PivotTable fields list, saving time when additional 
	 calculations are required

• 	Automatic time grouping: as long as Excel 2016 recognises your date and time fields, this feature assists use of time-related fields in PivotTables  
	 more powerfully, by auto-detecting and grouping them on your behalf.  Once grouped together, this may be dragged to your PivotTable in one  
	 action allowing more versatile analysis across the different levels of time with drill-down capabilities (this was a definite problem before)

• 	PivotChart drill-down buttons: allow you to drill in and out across groupings of time and other hierarchical structures within your data

• 	Search in the PivotTable: the field list helps you get to the fields that are important to you across your entire data set

• 	Smart rename: provides the ability to rename tables and columns in your workbook’s Data Model.  With each change, Excel 2016 automatically  
	 updates any related tables and calculations across your workbook, including all worksheets and DAX formulae.  This was a much-needed 	
	 obvious improvement.  Excel users are used to adding / removing rows and columns with formulae updating automatically and it is good to 	
	 see that Power Pivot has now caught up

• Multiple usability improvements: have also been made. For example, delayed updating allows you to perform multiple changes in Power  
	 Pivot without the need to wait until each is propagated across the workbook.  The changes will be undertaken at one time, once the Power 	
	 Pivot window is closed making larger models easier to work with.

This makes Power Query a lot easier to discover for novice users. There’s 
nothing to enable – it’s there by default – although there may be confusion 
between new and existing features on the Data tab.  One other thing we 
don’t understand here: Microsoft seemed to spend an eternity establishing 
the Power BI brand and now seems happy to throw it all away with the 
advent of Excel 2016.  Power to their elbow, we suppose.

Additional features available under the ‘Get & Transform’ section include 
accessing recent sources you have used in previous queries and options to 
combine queries together.  With what Microsoft refer to as a “premium 
version” of Excel 2016 (uh oh, it’s the Excel 2013 ProPlus issue all over 
again…) and a Power BI license, you can also use the search functionality 
to discover corporate data available to you across your company that is  

shared in a corporate catalogue or even share your own queries with others.

There are further benefits in Power Query programmability too. Now 
that its features are native to Excel, you can use VBA and the Object 
Model to program a related query and transform actions. Just like 
Power Pivot has the language DAX, if you find you need more than VBA 
provides, you can fall back on Power Query’s programming language (M) 
to create additional actions and capabilities.

Power Pivot and the Data Model have had improvements too.  In Excel 
2016, Microsoft announced that it is intending to make the features and 
functionalities “… more discoverable, consistent and streamlined…”.  To 
this end, there’s new features:
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We have already talked about M (see above); for Power Pivot users, there are plenty of new DAX functions in Excel 2016, including:

New DAX Function Description

ADDMISSINGITEMS Add the rows with empty measure values back

CALENDAR Returns a table with one column of all dates between StartDate and EndDate

CALENDARAUTO Returns a table with one column of dates calculated from the model automatically

CONCATENATEX Evaluates expression for each row on the table, then returns the concatenation of those values in a 
single string result, separated by the specified delimiter

CROSSFILTER Specifies cross filtering direction to be used in the evaluation of a DAX expression. The relationship is 
defined by naming, as arguments, the two columns that serve as endpoints

CURRENTGROUP Access to the (sub)table representing current group in GROUPBY function. Can be used only inside 
GROUPBY function

DATEDIFF Returns the number of units (unit specified in Interval) between the input two dates

GEOMEAN Returns geometric mean of given column reference

GEOMEANX Returns geometric mean of expression values in a table

GROUPBY Creates a summary of the input table grouped by the specified columns (sounds like crowd purchasing)

IGNORE Tags a measure expression specified in the call to SUMMARIZECOLUMNS function to be ignored when 
determining the non-blank rows

ISONORAFTER The ISONORAFTER function is a Boolean function that emulates the behaviour of StartAt clause and 
returns TRUE for a row that meets all the conditions mentioned as parameters in this function

KEYWORDMATCH Returns TRUE if there is a match between the MatchExpression and Text

MEDIANX Returns the 50th percentile of an expression’s values in a table

NATURALINNERJOIN Joins the Left table with Right table using the Inner Join semantic

NATURALLEFTOUTERJOIN Joins the Left table with Right table using the Left Outer Join semantics

PERCENTILE.EXC Returns the kth (exclusive) percentile of values in a column

PERCENTILE.INC Returns the kth (inclusive) percentile of values in a column

PERCENTILEX.EXC Returns the kth (exclusive) percentile of an expression’s values in a table

PERCENTILEX.INC Returns the kth (inclusive) percentile of an expression’s values in a table
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PRODUCT Returns the product of given column reference

PRODUCTX Returns the product of an expression’s values in a table

ROLLUPADDISSUBTOTAL Identifies a subset of columns specified in the call to SUMMARIZECOLUMNS function that should be 
used to calculate groups of subtotals

ROLLUPISSUBTOTAL Pairs up the rollup groups with the column added by ROLLUPADDISSUBTOTAL

SELECTCOLUMNS Returns a table with selected columns from the table and new columns specified by the DAX expressions

SUBSTITUTEWITHINDEX
Returns a table which represents the semi-join of two tables supplied and for which the common set of 
columns are replaced by a 0-based index column.  The index is based on the rows of the second table 
sorted by a specified order expression

SUMMARIZECOLUMNS Creates a summary table for the requested totals over a set of groups

XIRR Returns the internal rate of return for a schedule of cash flows that is not necessarily periodic

XNPV Returns the net present value for a schedule of cash flows that is not necessarily periodic

Some functions are very familiar; others may take time to understand fully.  
We are particularly interested in the capabilities of the new CALENDAR 
and CALENDARAUTO functions.  These may prove very useful…

If you ever get your head around all of these new DAX functions, once data 
analysis is completed, Excel 2016 provides the functionality to share it with 
your workgroup or clients through Power BI with literally just one button:

Microsoft Power View has now been added as a reporting option for an 
Online Analytical Processing (OLAP) cube connection in Excel 2016.  With 
your Excel spreadsheet connected to an OLAP cube, it is now possible to 
view this data in the Excel workbook as a Power View Report, complete with 
KPI’s, hierarchies, calculations and table data coming from the OLAP cube.

Given that previously blocked keyboarding scenarios in Excel for features 
like PivotTables and Slicers are now accessible too, clearly there have been 
some significant improvements to this key area of Excel.

There’s new forecasting capabilities in Excel 2016 too. In previous versions, 
only linear forecasting had been available via Excel functions, although 
SumProduct has run training courses to show you how these ideas may be 
extended.  It looks like the days of this course may be numbered.  In Excel 
2016, the FORECAST function has been extended to allow forecasting 
based on Exponential Smoothing (e.g. FORECAST.ETS()).  

Basically, the time series forecasting sheet functions are used to predict 
future values based on historical data.  For example, a monthly timeline 
with values on the first of every month.  For this type of timeline, it’s very 
useful to aggregate raw detailed data before you apply the forecast, which 
produces more accurate forecast results as well. To this end, the following 
forecasting functions are available:

	 •	 FORECAST.ETS() - Returns the forecasted value for a specific future 	
		   target date

	 •	 FORECAST.ETS.CONFINT() - Returns a confidence interval for the 		
	     forecast value at the specified target date

	 •	 FORECAST.ETS.SEASONALITY() - Returns the length of the repetitive 	
	     pattern Excel detects for the specified time series.

Probably more appealing to the masses, this functionality is also available 
as a new one-click forecasting button. From the Data tab, clicking the 
Forecast Sheet button quickly creates a forecast visualisation of the data 
series to be projected.  From this wizard, you can also find options to adjust 
common forecast parameters, such as seasonality, which is automatically 
detected with default and confidence intervals.

New Forecasting Capabilities
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Playing with this new feature at SumProduct, we must confess we have struggled to make charts look like the example graphic (above).  But like with all new 
things, when all else has failed, try reading the instructions…

The following new chart types are available:

	 •	 Financial: Waterfall  
	     (uh oh, another course falters…)

	 • Statistical: Histogram, Pareto, Box  
	    and Whisker

	 • Hierarchical: Treemap and Sunburst.

We show some example screenshots to the  
right and below: >

New Charts 
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With regard to charts, there has been another development as well.  The 
“3-D geospatial visualisation tool”, Power Map, is now accessible to all Excel 
2016 users.  Like other Power BI tools though, it has been renamed.  Power 
Map is now 3-D Maps and can be found along with other visualisation tools 
(that’s charts to you and me) on the Insert tab.

So what happens if you are using Excel 2013 or 2010 and open an Excel 
2016 workbook containing the new chart types or maps?  Rather than see 
the new chart, all you will see is a text box with a warning not to save your 
workbook into the older file format.

You may need to save files as PDF workbooks containing the new chart types or copy the graphics as pictures if you want people with previous versions of 
Excel to be able to view them.

Insights for Office
Already available in Word and Outlook, this functionality is now available 
in Excel and PowerPoint too.  With Insights for Office, users can learn 
more about their content by bringing in information in context of 
what you are reading or writing about.  Sources include Bing Snapshot, 
Wikipedia, Bing image search, the Oxford dictionary and Ashley Madison  

 

 
(ok, we made the last one up but it is publicly available now…).  Insights 
may be accessed by right clicking a word or phrase, through the Review 
tab on the Ribbon, or via the ‘Tell Me’ box.

Other New Features in Excel 2016 
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‘Tell Me’ saves you the time you would normally use to look for a specific function within the Ribbon.  You can type what you are looking for in the ‘Tell Me;’ 
box at the top right corner of the Ribbon in Excel (or Word, PowerPoint and Access) and with “word-wheeling”, as soon as you start typing every keystroke 
will refine the results so that you can click on what you are looking for as soon as you see it.  When you click in the ‘Tell Me’ box, you will also see a list of the 
last five commands you ran from within ‘Tell Me’, saving you time getting to the feature you want to use.

Tell Me
Is it true Clippy has returned?

Save As Improvements
These improvements streamline the saving process for new files by enabling you to pick a location in OneDrive, OneDrive for Business, or on your local 
machine, provide a file name, and then clicking Save.

Quick Data Linking in Visio
You can link a Visio diagram to Excel data and then transform your diagram into a dynamic dashboard.

Search In-Field List and Data Model Improvements
Excel Field List, used for adding fields to Pivot Tables and Pivot Charts, now supports search functionality so that you can quickly find the fields you are 
looking for in longer lists.

Read-Only Mode for Excel
New functionality means that you may open up an Excel workbook within SharePoint quickly in read-only mode to access files more quickly and 
securely.

Math Input Control
Already available in OneNote and Window, “math input control” (I can hardly bring myself to write that: whatever happened to English..?) is now 
available in Excel, as well as the other popular mathematical software packages, Word and PowerPoint.  You can write mathematical equations with a 
digital pen, a pointing device or even your finger, and have the ink converted to a “typed” format.  Or you could simply write it on paper.

Quick Shape Formatting 
This feature increases the number of default shape styles by introducing additional “preset” styles.
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Higher DPI Support for 250% and 300%
The preview has higher DPI support for Zoom views of 250% and 300% so that 
Excel will look better on larger screens.

Making it Easier to Share Files and Collaborate
From the Share dialog box, you can now bring together two key aspects of collaboration: who has access to a given document and who is currently 
working with you on the document.  We are still not sold on more than one person working in the same Excel file at the same time.

Data Loss Protection (DLP) in Excel
Data Loss Protection (DLP) is a high-value enterprise feature in Excel to enable the real-time scan of content based on a set of predefined policies for 
the most common sensitive data types (e.g. credit card numbers, social security numbers and bank account numbers).  This functionality allows IT 
administrators to have some oversight and help end-users better manage and store sensitive information (what, no Ashley Madison joke here? Ed.).

“It’s still saying Not Enough Resources To Display…”

Microsoft Announces Windows 10 Assistance

After recently having to explain some of the issues between Windows 10 and Excel 2010, it’s good to provide a more positive bulletin this time 
around.  Microsoft has announced a whole range of informative courses and blogs on Windows 10, chiefly aimed at the IT developer seeking to write 
applications rather than the Windows 10 newbie or Excel dabbler.

Feel free to peruse:

	 • Click https://www.microsoftvirtualacademy.com/en-US/training-courses/getting-started-with-windows-10-for-it-professionals-10629/	
		  for the Microsoft Virtual Academy for Windows 10

	 • Click https://dev.windows.com/en-us/getstarted/whats-new-windows-10/ for what’s new in development

	 • Click https://dev.windows.com/en-us/getstarted/ for getting started

	 • Click https://dev.windows.com/en-us/design/ for designing

	 • Click https://dev.windows.com/en-us/develop/ for developing

	 • Click https://dev.windows.com/en-us/publish/ for publishing.
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New Website

We know you will probably find it hard 
to contain yourselves, but SumProduct 
has re-vamped its website.  It’s still very 
much a work in progress, but aside from 
a new look, the new website will allow 
access to archived articles, online training, 
new improved information areas and 
other such niceties.  Not all of these new 
features will be available on Day 1, but it 
will allow for greater flexibility reflecting 
the content building up on this website.  
We hope you like it.

Many moons back we wrote a long article (that Tolstoy would have been 
impressed with) regarding which version of Office 2013 to buy.  Well Obi-
Wan, it’s all gone full circle and ahead of the upcoming full 2016 release 
we now need to inform you of what version of Excel 2016 to buy and why 
– and this time, there seems to be more clarity from the outset.

With the release of Excel 2016, Microsoft has provided two key 
improvements to their Office plans that make it easier to get the advanced 
“Power”-analytic features:

	 • Office 2016 Professional feature updates: Office 2016 Professional    
		  includes all of Excel’s business analytics capabilities, making it easier  
		   to take advantage of the complete suite as part of a one-time purchase  

		  of the Office desktop applications.  If you purchase the Office 365  
		  ProPlus subscription, which comes with Excel 2016, you will continue to  
		  receive ongoing updates and new features as they arise in the future;   
		  and

	 •	 Small business users: Office 365 small business users who are  
		  using one of the Office 365 Business Plans for most of their  
		  organisation can now purchase Office 365 ProPlus for users who  
		  need the premium features, leaving other users “as is”.

Microsoft has even created helpful diagrams to provide a holistic view of 
business analytics features offered in Excel 2016:

Which Excel 2016?

For more information, visit the full Microsoft article below at:  
https://blogs.office.com/2015/09/10/admins-get-ready-for-office-2016-rollout-begins-september-22/
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Registered Address: SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne VIC 3004
Melbourne Address: SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne VIC 3000

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:

· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management

If you require modelling assistance 
of any kind, please do not hesitate to 
contact us at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to several useful keystrokes you may or may not be aware of.  This month we’ve added a 
Window to the CTRL + Function Keys – particularly useful for all of the Mac users out there…

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.
com/thought/keyboard-shortcuts.

Keystroke What it does
CTRL + F4 Close Window

CTRL + F5 Restore Window

CTRL + F6 Next Window / Workbook

CTRL + F7 Move Window

CTRL + F8 Size Window

CTRL + F9 Minimise Window

Upcoming SumProduct Training Courses

Location Date Course Duration

Hong Kong 12th - 13th Oct 2015 Financial Modelling for Financial Analysis 2 days

Singapore 15th - 16th Oct 2015 Financial Modelling for Financial Analysis 2 days

London 19th - 21st Oct 2015 Strategic Planning, Forecasting and Budgeting 3 days

Singapore 19th - 22nd Oct 2015 Strategic Planning, Forecasting and Budgeting 4 days

Hong Kong 26th - 29th Oct 2015 Strategic Planning, Forecasting and Budgeting 4 days

Sydney 25th - 26th Nov 2015 Financial Modelling For Financial Analysis 2 days

Melbourne 30th Nov - 1 Dec 2015 Financial Modelling For Financial Analysis 2 days

Dubai 8th - 10th Dec 2015 Strategic Planning, Forecasting and Budgeting 3 days


